
This article describes the capabilities of A Simple Tool 
for Examining Fixations (ASTEF), an offline data analy-
sis application for processing eye-movement information. 
The tool was developed for specific needs in human fac-
tors and ergonomics (HF/E) research, because the analysis 
of individuals’ visual behavior has become increasingly 
popular in this field.

The path drawn by the eyes during the exploration (or 
scanning) of a scene has been dubbed scanpath (Noton 
& Stark, 1971)—a sequence of successive fixations and 
saccades (between fixations). Seminal work (e.g., Ellis & 
Smith, 1985; Ponsoda, Scott, & Findlay, 1995; Stark & 
Ellis, 1981) has been carried out for obtaining information 
about the visual search strategies that are possibly linked 
to variations in task demands. However, these studies have 
failed to show any computable effect of task complexity 
on visual scanning behavior. Nevertheless, the analysis of 
scanpath is still popular (e.g., Diez et al., 2001; Van Orden, 
Limbert, Makeig, & Jung, 2001) and is considered to be a 
valuable method for obtaining information concerning the 
operator’s strategies (e.g., about the areas of an interface 
that are inspected). Also, as recently stated by McCarley 
and Kramer (2007), oculomotor data can be used to draw 
inferences about the cognitive state or the level of mental 
workload of an individual.

Some studies have explored the ocular response in nov-
ice and expert participants involved in specific tasks. Par-
ticularly, shorter and more frequent fixations were recoded 
in expert operators (Bellenkes, Wickens, & Kramer, 1997; 
Miller, 1973), whereas more frequent fixations, with less 
consecutive time spent on the same object (shorter dwell 
time), were found in expert pilots during a landing flight 
phase (Kasarskis, Stehwien, Hickox, Aretz, & Wickens, 

2001). These findings showed that visual scanning char-
acteristics could be affected by expertise and suggested 
that the study of scanpath features could be useful for dis-
criminating good from poor performance.

Other studies (Bunecke, 1987; Ephrath, Tole, Stephens, 
& Young, 1980) have shown fixation duration to be af-
fected by workload variations. Provisional ocular metrics 
of mental workload that are based on the analysis of scan-
path were recommended over two decades ago (Ephrath 
et al., 1980; Harris, Glover, & Spady, 1986; Tole, Stephens, 
Vivaudou, Ephrath, & Young, 1983). Visual scanning ran-
domness (or entropy) was found to be related to mental 
workload: High task load conditions would generate less 
randomness than would low task load conditions. In other 
words, transitions of fixations between different areas of 
interest (AOIs) were reduced when mental workload was 
high, indicating attentional narrowing.

For decades, this finding has been reported as a fact, de-
spite there having been only a few articles (e.g., Hilburn, 
Jorna, Byrne, & Parasuraman, 1997) reporting similar 
results. Moreover, there is also evidence of an opposite 
pattern, namely that higher entropy could be associated 
with higher mental workload as well (Kruizinga, Mulder, 
& de Waard, 2006).

In recent studies from our laboratory (Camilli, Terenzi, 
& Di Nocera, 2007; Di Nocera, Camilli, & Terenzi, 
2007; Di Nocera, Terenzi, & Camilli, 2006), we used a 
different perspective for investigating the relationship 
between mental workload and fixation distributions. The 
type of spatial distribution produced by the fixations’ 
pattern was computed with a spatial statistics algorithm 
called the nearest neighbor index (NNI; Clark & Evans, 
1954).
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cipal variations in task demands were due to more strin-
gent temporal constraints: either rapidly executing many 
checks or quickly performing many operations.

In agreement with that, Di Nocera and Bolia (2007) 
recently proposed that two processes might respectively 
contribute to dispersion and grouping in visual scanning 
behavior: temporal demand and visuospatial demand. In-
deed, whereas studies that have reported grouping (not 
necessarily using entropy analysis; see Recarte & Nunes, 
2000) have challenged a visual primary task (e.g., driv-
ing or air traffic control) by using a secondary task that 
claimed resources from the very same pool (e.g., mental 
imagery, additional aircraft to control), studies reporting 
dispersion have devised task load conditions by manipu-
lating the temporal demand (e.g., brisk stimulation).

Both accounts may then be valid. Nevertheless, a criti-
cal issue for comparing different study perspectives is the 
standardization of the computational practices for deriv-
ing ocular metrics of mental workload. With that in mind, 
we have developed ASTEF, which will eventually permit 
other scientists to fully test different hypotheses in order 
to investigate the relationship between visual scanning be-
havior and mental workload.

Introducing ASTEF

Eyetracker manufacturers often provide software appli-
cations for playing back and analyzing the eye-movement 
data that are recorded by the system. Most of these ap-
plications offer several interesting features—sometimes 
many more than those required by the investigators using 
them. Also, the great number of functions makes these 
applications resource consuming and way too compli-
cated for rapid and easy manipulation of coordinate data. 
In contrast, ASTEF development has been aimed at hav-
ing a small application coded in C#.NET and running on 
Microsoft Windows machines, allowing specific analyses 
of ocular data in a bidimensional space. The following 
sections will introduce three main capabilities of this 
simple tool: visualization, analysis of fixation data (AOI 
and fixation distribution), and fixation identification.

Visualization
Qualitative inspection of the sequence of fixations is 

one of the first tasks carried out by researchers working 
with ocular data. That might serve either as a checking 
procedure for assessing the quality of the recording or as 
a method for addressing the objective of the study (e.g., 
defining AOIs).

ASTEF permits visualization of the recorded scanpath 
in several different ways:

1.	visualizing the succession of the fixations on the 
screen in pixel coordinates (using the customiz-
able axes and grids or hiding them);

2.	superimposing the scanpath on to a scanned scene 
(e.g., a snapshot of the visual task scenario);

3.	replaying the scanpath concurrently with other 
recorded features (i.e., temporal interval between 
successive fixations and duration of each fixa-

In the earliest of the studies above (Di Nocera et al., 
2006), participants were engaged in two task conditions 
(easy and difficult) of the Asteroids arcade game. In this 
case, the nature of the tasks that were displayed was dy-
namic; that is, the visual components of the scene (the ship 
and the asteroids) constantly moved across the screen. An 
additional study (Di Nocera et al., 2007) involved 10 pro-
fessional pilots who were requested to perform a simulated 
flight across five different phases (departure, climb, cruise, 
descent, landing). The visual scanning behavior was ana-
lyzed on a static-displayed scene (the cockpit instrument 
panel). In both studies, fixations appeared to be (near ran-
domly) dispersed when workload was high, and grouped 
when workload was low. The validity of the NNI as a mea-
sure of mental workload was addressed in a subsequent 
methodological study (Camilli et al., 2007). In this case, 
participants were required to perform at different difficulty 
levels of the Tetris game. The NNI was contrasted with 
two concurrent measures—P300 and the NASA task load 
index (NASA–TLX)—frequently used as mental workload 
indicators. The results showed consistency between sub-
jective (NASA–TLX scores), psychophysiological (P300 
amplitude), and ocular (NNI) indexes.

Given its stability and validity, the spatial statistics ac-
count appears to serve as satisfactorily as does the en-
tropy account. There are also reasons to actually prefer 
the former to the latter. Entropy needs a priori definition 
of AOIs, whereas spatial analysis eliminates this rather 
subjective element, and many studies have addressed 
the analysis of scanpath using a narrow field of view in 
which many features of the scene might be accessed pe-
ripherally. Although the term scanpath is often informally 
used to describe any eye-movement recording, Noton and 
Stark (1971) specifically state that a scanpath is obtained 
thusly: “If patterns are presented to a subject under con-
ditions of poor visibility, so that he is forced to look di-
rectly (foveally) at each feature to which he wishes to at-
tend, then the position of his eyes will reveal the features 
processed and his saccadic eye movements from feature 
to feature will reveal the order of processing” (p. 308). 
Obviously, conditions for studying the sequence of fixa-
tions do not hold in other cases. Moreover, in contrast to 
entropy calculation, spatial analysis takes into account 
all fixations (without loss of information), considering 
the fixation points’ coordinates to be valuable sources for 
establishing how they are spatially distributed. Further-
more, the NNI can be computed over small epochs of 1 or 
2 min, providing information about the temporal aspects 
of scans and allowing the monitoring of the functional 
state of an individual (see Camilli et al., 2007; Di Nocera 
et al., 2007).

Although more work has to be done in order to un-
derstand the functional significance of the relationship 
between fixation distribution and mental workload, it is 
plausible that it might reflect the use of different visual 
scanning strategies. Indeed, in complex and more demand-
ing task situations, a wider fixation pattern (i.e., random 
or near random) might be used to optimize prompt attend-
ing to incoming information. This account makes sense, 
considering that, in the studies reported above, the prin-
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5.	flag—optional information that can be added by 
the experimenter for defining the experimental 
condition to which the fixation belongs.

Given that any eye-tracking system provides eye coordi-
nates and timing, it is easy to edit any ASCII tab-separated 
data file in order to make it readable by ASTEF. Sample 
input files are available in the default folder (\astef 1.2\
data\input\samples).

Any graphic file format can be imported as background. 
This function is quite useful for playing the scanpath back 
over a meaningful picture in order to derive information 
about the participants’ ocular behavior. For example, when 
a participant interacts with a software interface and the 
scanpath is subsequently played back over a screenshot of 
the very same interface, it is easy to examine the location 
of most of the fixations and the type of strategy used.

Scanpaths can be exported as ASCII data files (ASTEF 
formatted), static images, and video clips (Figure 2). The 
video exporting function uses Microsoft Windows applica-
tion programming interfaces. In order to export animated 
scanpaths in the desired format, users can use their sys-
tem’s video codecs (e.g., Microsoft MPEG and Intel Indeo) 
or install those they prefer for customizing the speed and 
quality of video compression (e.g., DivX and Xvid).

AOI analysis. Analysis of temporal dynamics of the 
scanpath is one of the primary tasks accomplished by 
ASTEF. This is a common task for researchers who need 
to examine the progression of fixations in order to identify 
AOIs. In several studies (e.g., Diez et al., 2001; Hilburn 
et al., 1997), the definition of the AOIs was based on a pri-
ori criteria, taking into consideration what were assumed to 
be the most informative interface regions. These are con-
sidered by the researcher to be the necessary visual regions 
to be viewed by participants for performing a specific task. 

tion) by clicking over the progress bar located at 
the bottom of the interface; or

4.	scrolling the fixation sequence rapidly (forward or 
backward).

The default starting time of scanpath playback is the 
beginning of the recording session. However, a particular 
instance in time (or a given fixation number) can also be 
reached either by using the “Go To” function to click over 
the magnifier icon located at the bottom right-hand corner 
of the interface or by dragging the slider on the progress 
bar from side to side. Figure 1 shows a sample scanpath 
superimposed onto a snapshot of the task interface.

ASTEF groups most of the visualization functions in 
the “File” menu, which allows the loading, exporting, and 
saving of the scanpaths. By default, visualization includes 
grid, points, lines, and background images (if available). 
The “Visualize” menu allows rapid customization of the 
view. Also, by clicking over fixation points, saccades 
lines, and grids, it is possible to customize line thickness, 
circle radius, and colors.

In order to visualize the scanpath, a properly formatted 
input file must be opened. ASTEF input files must include 
the following information:

1.	area size—the area in which the scanpath evolves 
(e.g., 1,024  768 pixels);

2.	fixation recording start time—timing information 
that might be useful for data sync;

3.	fixation duration—duration of the fixation, in 
milliseconds;

4.	fixation coordinates—pixel coordinates (x,y) de-
fining the fixation position in the area (origin is 
located at the upper left-hand corner); and

Figure 1. Example of scanpath visualization over a snapshot of a task scene.
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4. mean, standard deviation, and median of fixation 
duration.

This information is also accessible by right-clicking over 
either the whole scanpath or the single AOI.

Fixation Distribution Analysis
The present release of ASTEF (as of this article’s pub-

lication) implements the NNI (or R, as it was originally 
introduced) as a measure of spatial dispersion (Figure 4). 
As reported by Clark and Evans (1954, p. 447), “distance 
from an individual to its nearest neighbor, irrespective of 
direction, provides the basis for this measure of spacing.” 
This approach may be applied to any point pattern, and it 
was indeed applied to distributions of plants and animals. 
Given that fixations are point patterns as well, fixation 
distributions can also be analyzed using this method. In 
fact, if, in a set of N fixations having a specified density ρ 
(the number of fixations per unit of area), we measure the 
distance r from each fixation to its nearest neighbor, the 
mean observed distance may be represented as

	 r
r

NA = ∑ . 	

The mean distance that would be expected if this set of 
fixations were distributed at random, rE, can be shown to 
have a value equal to

	
1

2 ρ
	

(demonstration is available in Clark & Evans, 1954, 
pp. 451– 452). The ratio

In contrast, other researchers (e.g., Salvucci & Goldberg, 
2000) used a different approach for defining an AOI: the 
observation of fixations on a visual target and area. In other 
words, the recording of either frequent fixations or of their 
longer duration on the same visual area marks that area as 
being an AOI. In either case, the selection of an AOI is eas-
ily accomplished by using ASTEF, which implements area 
selection on visualized scanpath in three different ways:

1.	dragging the diagonal of a rectangle (Figure 3A);

2.	moving the four sides of the rectangle separately, 
dragging the four corresponding cursors with the 
use of the mouse (Figure 3B); or

3.	clicking on the “Input Area Selection Coord” icon 
(icon array at the bottom right-hand corner) and 
inserting the exact coordinates manually in the 
“Manual Selection Area” form (Figure 3C).

ASTEF also provides the capability to invert selections 
(Figure 3D). This is useful for operating on points out-
side an AOI (e.g., deleting all the points outside the AOI). 
During the selection procedures, the area size and mouse 
pointer coordinates are always visible in the status bar. All 
the selected AOIs can be named and saved for further use 
from the “AOIs” menu.

The “Analyze” menu has two functions—“fixation 
inspection” and “fixation duration”—that provide basic 
scanpath information including the following:

1. number of fixations;

2. earliest and latest fixation (ID and position in the 
timeline);

3. shorter and longer fixation (ID and duration); and

Figure 2. Example of scanpath clip exporting. Create AVI: Setup of start time and 
end time of recording. Compressione video: the choice of the codec for video compres-
sion. Configure: the configuration of the codec parameters.
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latter permits the consideration of collected fixations that 
occur on one region of the screen. After the determination 
of the screen analysis region, ASTEF permits the use of 
two different types of area (processed in the R algorithm) 
for computing the NNI: convex hull (CH) and smallest 
rectangle (SR). CH is derived by Delaunay’s algorithm 
(Delaunay, 1934), which creates a temporary hull from 
the first three points, and then adds other triangles for 
each outer point (Figure 5A). SR is based on an algorithm 
that creates a bounding box for defining the rectangle that 
has the smallest area comprising all the examined points 
(Figure 5B).

For the CH, ASTEF also implements the Donnelly’s 
edge effect adjustment method (Donnelly, 1978). Donnel-
ly’s correction is obtained by adding the following to rE

–:
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can then be used as a measure of the degree to which the 
observed distribution approaches or departs from random 
probability. Therefore, this procedure provides a single 
value that is indicative of the type of distribution on which 
it has been computed. As reported above, the mean dis-
tance between pairs of nearest neighbors is compared with 
that expected on the basis of chance. The actual mean 
distances can be smaller (points are aggregated; R , 1), 
larger (points are regularly dispersed; R . 1), or not dif-
ferent from the expected distances (points are randomly 
dispersed; R 5 1). The statistical significance of this index 
can also be derived, but, for the purposes of its application 
to the measure of mental workload, only the “raw” index 
has been used so far.

In ASTEF, it is possible to calculate R either on the 
whole screen area or on a selected AOI (see Figure 4). The 

Figure 3. Different ways to select areas of interest in ASTEF. See text for explanation.
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1.	number of observation: number of the epoch within 
the whole recording time;

2.	number of fixations within the matching epoch;

3.	R value within the matching epoch, computed using 
the CH area;

4.	R value within the matching epoch, computed using 
the SR area;

5.	mean fixation duration within the matching epoch; 
and

6.	median fixation duration within the matching 
epoch.

Fixations Identifier Tool
The analysis of fixations requires, as a first step, ma-

nipulation of the raw gaze data for identifying location 
and duration of each fixation point. This reduction allows 
minimizing the complexity of raw eye-movement data by 
collapsing gaze points sets in one or more fixation points.

It is a generally accepted fact that visual/cognitive pro-
cesses occur during fixation (see, e.g., Just & Carpenter, 
1984). Indeed, no visual processing can be obtained dur-
ing a saccade (Goldberg & Schryver, 1995), and small 
eye movements (e.g., tremors, drifts, and flicks) are unim-
portant for higher level cognitive analyses (Alpern, 1962). 
Nevertheless, identifying fixation locations from raw gaze 
data still appears to be a subjective process, and poor defi-
nition of fixation identification algorithms might end in 
too many or too few fixations. An algorithm might also 
be too sensitive to the presence of outlier gaze points that 
could bias the interpretation of visual search paths (see 
also Salvucci & Goldberg, 2000).

This section describes the tool for identifying fixations 
that is implemented in ASTEF. Its identification process 
is a space/time-based method that separates fixation and 

where A is the study area and B is the length of the perim-
eter of the study area.

In order to investigate the visual scanning behavior via 
the R analysis, the choice to use the CH rather than the SR 
(or vice versa) could be based on methodological assump-
tions of the researchers only.

The release of ASTEF that is described in this article 
also implements the R time series analysis. This function is 
available from the “Analyze” menu. This type of analysis, as 
briefly discussed in the Introduction section, could be very 
useful for obtaining continuous information about individ-
uals’ ocular behavior. More specifically, the “time series” 
function asks the user to insert the interval (in milliseconds) 
that represents the epoch within which R is calculated.

The time series output provides an ASCII tab-separated 
data file that includes the following information:

Figure 4. Example of the nearest neighbor index (NNI) compu-
tation results on one area of interest.

Figure 5. (A) Convex hull and (B) smallest rectangle are two types of envelopes for point patterns. The figure shows the two 
types over the same point pattern.

A B
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number of the participant, condition, and trial). This col-
umn is processed by the fixation identifier algorithm and 
by reducing a gaze data file if any information is lost. In 
brief, the algorithm signs a noted fixation with the de-
scription of its first gaze (i.e., matching with the fixation 
start time).

In order to identify a list of fixations, a gaze data file 
properly formatted (i.e., ASCII tab-separated) should be 
opened.

Fixation identifier input files include the following 
information:

1.	timestamp—timing information about each re-
corded gaze;

2.	pupil—pupil diameter information for each eye 
(sx,dx);

3.	validity codes—gaze recording quality for each 
eye (sx,dx);

4.	gaze point—pixel coordinates (x,y) of the gaze lo-
cation in the area (origin is located at the upper 
left-hand corner); and

5.	flag—optional information that can be added by 
the experimenter for defining the experimental 
condition to which the gaze belongs.

ASTEF Validation

In order to validate the ASTEF, its results have been 
compared with the results obtained through the use of other 
software. The ASTEF identification process for detecting 
fixation data from a raw gaze data file has been compared 
with that of ClearView (Tobii Technology, Sweden) and of 
iComponent (Špakov, 2006a). The first is a commercial 
software suite, and the second is open-source software.

The ASTEF NNI (R) function has been compared with 
paleontological statistics (PAST; Hammer, Harper, & 
Ryan, 2001), a free data analysis package used in paleontol-
ogy that includes a module for computing the R statistics.

Fixations
The fixation data obtained by the fixation identifier 

tool in ASTEF have been compared with the outputs 
of ClearView and of the fixations detector tool (Špakov, 
2006b) implemented in iComponent. Sample gaze raw 
data from a task in which individuals freely explored a 
picture were used. An eyetracker device at 33Hz was used 
for collecting eye-movement data on a 4:3, 17-in. display 
having a 1,024  768 pixel resolution. The identification 
algorithms of the three different packages were all based 
on spatial–temporal threshold parameters. In all three 
identifications, the algorithms’ values were the projection 
of 1º visual angle—which, at an approximate distance of 
50 cm, was equivalent to about a 25-pixel radius—and the 
minimal fixation duration of 100 msec. The three scan-
paths (Figure 7) generated by the three different fixation 
identifications showed two minimal differences between 
them: (1) ClearView and iComponent detected one fixa-
tion more than did ASTEF, and (2) ASTEF and iCompo-
nent detected one fixation less than did ClearView.

saccade points on their point-to-point location and perma-
nence inside that location.

The “Fixation Identifier” tool is available from the “Tools” 
menu. Figure 6 illustrates (in pseudocode form) the identi-
fication algorithm process.

In order to obtain fixations, the user needs to set two 
parameters: “Min Fixation Duration” (in milliseconds), 
which is the minimum duration of the fixation, and “Ra-
dius” (in pixels), which is the minimum fixation radius. 
The latter is nothing more than the projection on the screen 
of the threshold visual angle. Default values are those fre-
quently reported in the literature (Hornof & Halverson, 
2002; Jacob & Karn, 2003; Jainta & Jaschinski, 2002; 
Kramer & McCarley, 2003; Salvucci & Goldberg, 2000): 
0.5º to 1º of visual angle and 100–200 msec of duration.

A noise filter is also implemented, because sporadic 
points falling outside the fixations may be found during 
the identification process (Alpern, 1962; Ditchburn, 1980; 
Hornof & Halverson, 2002). Sometimes, after a first out-
lier, several other points may fall into the identified fixa-
tion. Ignoring those points may cause a biased estimate; 
for this reason, a noise filter has been implemented in 
order to check for the timing of those points occurring 
after the outlier point.

Given that the quality of a recorded gaze is affected by 
many factors (e.g., head movements, glasses, and contact 
lenses), ASTEF also implements two columns in the gaze 
data files that refer to the sampling quality (one for each 
eye). A 0 to 4 validity range is used, where 0 represents 
the best tracking quality. However, this information is not 
fully processed in the present release of the software (as of 
this article’s publication), and only those gazes having the 
maximum tracking validity (0 coded) are taken into con-
sideration. Such strictness is necessary due to the fact that 
lower validity reflects a lack of information about some 
features of the gaze (e.g., either the eye coordinates are 
missing or they are poorly precise), and it is our opinion 
that it is much more appropriate to exclude those sam-
ples. Nevertheless, future versions will implement a user-
defined rejection threshold.

The last column of each ASTEF gaze data file is named 
“Flag.” This could contain additional information (e.g., 

Figure 6. Pseudocode for the fixation identifier algorithm, 
adapted from Salvucci and Goldberg (2000, p. 74).
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NNI
As reported above, the spatial statistics function of 

ASTEF has been validated by comparison with PAST. 
PAST is a data analysis package that includes several 
functions that are commonly used in paleontology and 
ecology; it does not, therefore, provide any specific func-
tion for scanpath analysis. The same fixation data used for 
validating the fixation identification tool were used in this 
validation. Comparisons were made using both the CH 
and the SR algorithms. Donnelly’s edge correction was 
implemented by default.

The results (Table 1) showed that the R values were very 
similar. Particularly, R values were exactly the same when 
using the SR area, and they were only slightly different when 
using the CH area. The negligible differences in the CH op-
tion were probably due to differences in approximation.

These small discrepancies were probably due to neg-
ligible differences in the approximation of the fixation 
centroid—namely, in the calculation of the distance be-
tween each gaze and the center of the current fixation.

Moreover, while ASTEF and iComponent implement 
very similar noise filters, ClearView does not implement 
any filter in detecting fixations. This aspect is clearly ob-
servable from the comparison of the three different sets 
of fixation data. In fact, the inspection of the ClearView 
fixation output showed a higher number of fixations (174) 
and smaller durations (mean 5 271 msec) than did ASTEF 
and iComponent outputs: 153 and 155 fixations, and 296- 
and 299-msec mean durations, respectively.

Overall, the comparison shows the validity of the out-
put obtained with the fixation identifier tool implemented 
in ASTEF.

Figure 7. Scanpaths obtained by (A) ASTEF, (B) ClearView, and (C) iComponent.
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latter function was added during the writing of the present 
article, and future plans have been made to add a complete 
set of techniques suited for fixation spatial distribution 
analysis in the HF/E domain.
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